
Experiment HP-12: Rubber Hand Illusion

Lab written and contributed by: Dr. Jim Grigsby, Professor of Psychology & Professor of Medicine 

(Division of Health Care Policy and Research, Division of Geriatrics), and

Mr. Greg Fliney, Senior Research Specialist University of Colorado, Denver

Equipment Required

PC or Mac Computer

IXTA, USB cable, IXTA power supply

C-GSR-320 electrodes

PPG-320 Pulse plethysmograph

TM-100 temperature sensor

Rubber Hand (right) – with a shirt sleeve attached that matches the dress shirt

Large button-down dress shirt

Corregated cardboard or wood box (60 cm x approx. 30 cm)

Two-way mirror

Black fabric

Meter stick

2 Small child's paintbrushes or make-up brushes

Surgical tape

Light source

Appendix for the Questionnaires for Subjects

Optional - ROAM EMG 

GSR and PPG-320 Setup

1. Locate the PPG-320 pulse plethysmograph sensor and plug it into the PT port. Place the PPG-

320 on the subject’s middle finger.

2. Locate the GSR electrodes, plug the cable into channel A7.

• Moisten the finger tips with GSR conductive paste and attach the GSR electrodes to the 

pointer and ring finger of the subject's hand.  Make sure the fingers are not too cold or too 

dry.

3. Plug the TM-100 into channel A5.

4. If using connect the ROAM for recording EMG activity as shown.
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Note – the GSR unit is precalibrated.  No other calibration is needed.

Figure HP-8-S3: The equipment needed to record the information for the Rubber Hand Illusion lab: 

GSR and temperature. Pulse will be plugged into the PT port.

Corregated Cardboard/Wood Box Description and Set Up 

1. The box is composed of two compartments that are separated by a divider.

2. The compartments are open to both the subject and the researcher (who is sitting on the 

opposite side of the rubber hand illusion box). 

3. The compartments are also open at the top where there is a continuous two-way mirror that 

covers the top of the entire box. 

4. From the subject’s perspective, the left compartment contains the rubber hand and the subject’s 

right hand is placed in the right compartment. 

5. There is a black veil covering the openings that are facing the subject and researcher to 

minimize the light that enters the box. This ensures that the two-way mirror appears to be a 

purely reflective mirror. 

6. The black veil also covers the top of the right compartment (while still being underneath the 

two-way mirror) so that the subject can never see their hand throughout the illusion.

7. In the left compartment (where the rubber hand is located), there is a light source that, when 

turned on, illuminates the compartment so that the rubber hand becomes visible. In other words,

the mirror becomes translucent because there is light beneath it.
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8. Each compartment has a mark where the actual and rubber hand’s right index fingers are placed.

• The total distance between these markings is 30 cm 

• The distance from the right edge of the box (from the subject’s perspective) to the subject’s 

actual right index finger is 15 cm. 

• The length of the box is 60 cm x 30 cm with the divider placed in the center (30 cm from 

either side of the box).   

Figure HP-12-S6: Rubber Hand Illusion box set up.

Note: These exercises are best performed in groups of 3 individuals. Plan accordingly so that each 

group has enough members to perform the lab.

SEE APPENDIX FOR QUESTIONNAIRES FOR THIS EXPERIMENT.
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Experiment HP-12: Rubber Hand Illusion

Lab written and contributed by: Dr. Jim Grigsby, Professor of Psychology & Professor of Medicine 

(Division of Health Care Policy and Research, Division of Geriatrics), and

Mr. Greg Fliney, Senior Research Specialist University of Colorado, Denver

Illusion Box Set Up

Note: The box can be made of sturdy corrugated cardboard or wood.

1. Set up the box as stated in the Set Up document for this lab.

2. Mark the location in the right hand compartment where the subject is to place their right hand. 

Mark the location of the index finger for the rubber hand to be placed in the left compartment.

3. Place the rubber hand in the same location in the left hand compartment of the box so that the 

index finger is placed on the mark.

4. Ensure that only the cut sleeve attached to the rubber hand is visible and is coming out from the 

bottom of the veil.

5. Position the subject so that their body is midline to the rubber hand.

Preparation of Subject

1. Have the subject answer both the Background and Lifestyle Questionnaire, and the Imagination 

Questionnaire in the Appendix.

2. Once the subject has answered the questionnaires, have them put on the shirt.

3. See the Setup documents for placement of the sensors on the hand.

4. Before recording any physiological data, place a two-foot ruler over the box, and have the 

subject verbalize where it feels like their right index finger is located by reading the location off

of the ruler in centimeters. Record the value. Remove the ruler from the top of the box.

Exercise 1: Recording Baseline Data and the Rubber Hand Illusion Data

Aim: To measure the subject’s physiological parameters for 1 minute of baseline data and 1minute of 

illusion data.

Approximate Time: 15 minutes

Procedure

1. Record a baseline recording of physiological function for 1 minute (do not disturb the subject or

perform any other tasks at this time).

2. Type Baseline Data <Subject’s Name> in the Mark box. 

3. Click on the Record button. Click the Mark button.
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 There should be no light in the 

box.



4. Record for at least 1 full minute. Click Stop to halt the recording.

5. Select Save As in the File menu, type a name for the file. Click on the Save button to save the 

data file. 

6. After 1 minute, turn the light on to illuminate the rubber hand compartment of the box and 

immediately begin the illusion. 

7. Ask the subject to focus on the rubber hand. NOTE: The subject’s actual hand should not be 

visible throughout the illusion. 

8. Make a notation in LabScribe that brushing has begun by typing Brushing in the Mark box and 

clicking the Mark button.

9. Using two paintbrushes, brush the rubber hand and actual hand from the knuckles to the tips of 

the fingers for 1 minute. Be sure to brush each finger within this 1 minute interval.  Make sure 

to brush the same fingers on the subject's hand as on the rubber hand, make sure to brush at the 

same speed for each.

10.  After this interval, turn off the light, make a mark in LabScribe that the Brushing Ceased by 

typing in the mark box and clicking the Mark button.

11. Place the ruler back on top of the box. When you place the ruler back on the box, be sure to 

place it so that the ruler is reversed (turned 180 degrees from the previous measurement). The 

numbers should be upside-down from the subject’s perspective. (Note: This ensures that the 

subject will not simply recall the last measurement.)

12.  Ask the subject to verbalize where it feels like their right index finger is located by reading the 

location off of the ruler in centimeters. Rccord the value.

13. Remove the ruler and continue recording the physiological functions for at least 1 minute. Do 

not disturb the subject or perform any other tasks at this time.

14.  Click on the Save button to save the data file. 
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Figure HP-12-L2: The recording showing the period of 1 minute while the both subject's hand and the 

rubber hand are being brushed.

15. Once the recording is complete, remove the subject’s hand from the box and remove all 

recording devices. 

Data Analysis – Baseline – Before Brushing

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Baseline Data <Subject's Name>.  This will automatically bring the 

recording to the data recorded during baseline.

2. Place the cursors so they are on either side of the data.

Human Psychophysiology -Rubber Hand Illusion – Labs HP-12-3



Figure HP-12-L3: Data recorded during brushing of the hand as displayed in the analysis window.  

Note that mean values for heart rate, skin conductance and temperature, as well as the absolute 

integral for EMG are all displayed in this window.

3. Use the Double Display Time icon to adjust the Display Time of the Main window to display 

the full one minute recording of the subject’s baseline data on the Main window. This section of

data can also be selected by:

• Placing the cursors on either side of the one minute recording of the subject’s data, and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand or 

contract the one minute recording to the width of the Main window.

3. Click on the Analysis window icon in the toolbar.

Figure HP-8-L4: The LabScribe toolbar. 
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4. Look at the Function Table that is above the Pulse channel. The mathematical functions: T2-T1,

Mean and Abs. Int, should appear in this table. The values for time, mean heart rate, mean skin 

conductance and mean temperature, as well as the absolute integral of the EMG channels is 

displayed in the table across the top margin of the each of the labeled channels.

5. Once the cursors are placed in the correct positions for determining these values in the one 

minute recording, the values can be recorded in the on-line notebook of LabScribe by typing the

name and value of the parameter directly into the Journal.

6. The functions in the channel menu of the Analysis window can also be used to enter the names 

and values of the parameters from the recording to the Journal. To use these functions:

• Place the cursors at the location stated above.

• Transfer the names of the parameters to the Journal using the Add Title to Journal 

function in the Tools menu.

• Transfer the values using the Add All Data to Journal function in the Tools menu.

7. Enter these values for the subject's Baseline in Table 1.

Data Analysis – Brushing

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Brushing.  This will automatically bring the recording to the data recorded 

while brushing both the subject's hand and the rubber hand.

2. Repeat steps 2 through 6 from the baseline directions to analyze the data from the subject 

during the brushing of the hand.

3. Enter the data for the subject in Table 1.

Data Analysis – Brushing Ceased

1. Click the down arrow to the right of the Mark button to display the marks made while 

recording.  Choose Brushing Ceased.  This will automatically bring the recording to the data 

recorded after brushing occurred.

2. Repeat steps 2 through 6 as stated above to analyze the data from the subject after brushing has 

ceased.

3. Enter the data for the subject in Table 1.
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Table HP-8-L1: Mean Heart Rate, SCL, Temperature and Abs. Int from EMG Recorded Before, 

During and After Brushing for the Rubber Hand Illusion.

Subject’s Name

______________

Mean Heart Rate 

(bpm)

Mean SCL

(uSiemens)

Mean

Temperature (C)
Abs. Int. EMG 

Baseline

During Brushing

Brushing Ceased

Ruler

measurements

Questions

1. Does the recording show a difference in mean heart rate in response to the brushing of hand or 

after brushing has ceased?

2. Does the recording show a difference in mean skin conduction in response to the brushing of 

hand or after brushing has ceased?

3. Does the recording show a difference in mean skin temperature in response to the brushing of 

hand or after brushing has ceased?

4. Is there any correlation between the changes in mean skin conduction, temperature and/or the 

heart rate during brushing or after?

5. Look at the EMG activity of the hand during baseline and while the hand was being brushed.  Is

there any change, an increase or decrease, in EMG activity?  What would cause this to happen?

6. Explain how the Rubber Hand Illusion works.
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Exercise 2: Optional Experiments

Aim: To determine the changes in the heart rate, skin conductance level, temperature and EMG activity

while performing other stimuli on the rubber hand only. 

Approximate Time: 20 minutes

Procedure

Note: All tasks will be performed on the rubber hand only after doing the above tests.  

The above tests MUST be performed in order to continue with the optional 

experiments listed below.

1. Brush only the rubber hand for 1 minute while recording data.  

• After the “Brushing Ceased” experiment, record 1 more minute of data while brushing 

the rubber hand only.

2. Attempt to “threaten” the Rubber Hand with a small knife (do not actually stab the hand) or 

lightly hitting the rubber hand with your fist multiple times. Record 1 minute of data while 

“threatening” the rubber hand.

3. Place the rubber hand on ice. Record 1 minute of data while the rubber hand is on ice.

Data Analysis

Analyze the data for any of these optional experiments by following the Data Analysis directions for 

the Rubber Hand Illusion.
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